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Introduction

Welcome!

LABEL MATRIX 8 label design and integration software
provides an easy-to-use, user-friendly solution for printing bar
code labels and tags to meet compliance standards in any
industry. 

What’s New? New features in version 8 include:

• Updated Interface - New look and new toolbar buttons

• Advanced RFID Label Printing - Encode both HF and 
UHF radio frequency tags

• Enhanced Print Preview - New “live” preview allows you 
to view actual variable data as it will print on your labels

• TextArt - Allows text to be “bent” at precise angles to fit 
a selected shape type (ellipse, polygon, rectangle, etc.) 
and formatted using custom borders and backgrounds

• Label Backgrounds - Use a non-printing “base layer” 
outline to make your label design process easier

• Expansion Variables - Create code placeholders to 
reduce the size of large expressions with repeating code

• Bundle Save - A label design and its associated files can 
be saved as a “bundle” to simplify the process of moving 
label files from one PC to another

• SQL Query Builder - Wizard for creating an SQL statement

For a complete listing of all new features, printer drivers and
corrections in LABEL MATRIX 8, see the program’s Readme.txt
file.

e
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LABEL MATRIX 
Editions

LABEL MATRIX label design software is available in three
editions — LM QuickDraw, LABEL MATRIX, and LM PowerPro.
(The edition and release number for your software are printed
on a label located on the LABEL MATRIX box.) The following
table provides an overview of the main features included in
each edition.

FEATURE LM QuickDraw LABEL MATRIX LM PowerPro
General
Print-only version  • • 
Network version  • • 
Keyless software activation • • • 
Live Print Preview (view multiple labels with “live” 
variable data displayed) • • 

Label specific security • •
Over 100 compliance label templates • •
Label Background templates with round label 
formats Open Open Open/Edit

Automatic paragraph sizing and scale to fit • • 
Bulleted & numbered lists with hanging indents • • 
Graphic formats import (bmp, pcx, jpg, tif, etc.) • • • 
Color support • • • 
Linear bar code support • • • 
HIBC support • • • 
UCC/EAN 128 and MaxiCode wizards  • • 
2D bar code support  • • 
Extended 2D support (TLC 39 and QR Code)   • 
TextArt Objects/RTF Editor  • • 
Variables
Keyboard entry at print time • • • 
Double entry (verification) ability • • 
Pick List data entry • • • 
Data retrieved from a database file • • •
Counters (serial numbers) with support for alpha/
numeric • • •

Counters with custom numbering abilities • •
Date and time stamping using multiple formats • • •
Advanced math, string and logical functions • •
Expansion Variables (use code “shortcuts” in 
expressions) • •

Database
Configure an ODBC/OLE DB data source  • • 
Sequential database access  • • • 
Keyed database access  • • 
SQL query capability/SQL Query Builder Wizard  • • 
Retrieve data from unlimited number of databases 
per label  • • 
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Other LABEL MATRIX Configurations

Full Design and 
PrintPack Versions

LABEL MATRIX is available in a Full Design version and in a
PrintPack (print only) version. The Full Design version is
required in order to design, edit and save label design files.
The PrintPack version must be used in conjunction with a Full
Design version. LABEL MATRIX PrintPack is limited to only
opening and printing labels; you cannot add, move, delete or
edit fields on a label.

Single and 
Network Versions

A LABEL MATRIX Single-User version is a stand-alone program
that is intended to be installed on one PC. The LABEL MATRIX
Network version is a multi-user license. For more information
on the Network version of LABEL MATRIX, see Chapter 3,
"Network Licensing Setup".

Includes separate Database Editor program  • • 
Data Grid for viewing database records • • •
Directly edit database records in the Data Grid •
Printing
Windows driver printer support • • • 
Support for over 1000 thermal and thermal transfer 
printers  • • 

Variable duplicate label count from any origin • • • 
Stacked printing ability with multiple labels per 
page  • 

Reverse the order of pages in a print job • 
Tools
Pocket LABEL MATRIX support (0 licenses) (1 license)
Directly modify printer code with Job Modifier utility • • 
Automatic printing from a source database 
(AutoPrint)  • • 

Command line support • •
Export image and variable information to a data 
file (Write Data) • • 

Save all external attached files with the label 
design (Bundle Save)  • • 

View & customize reports generated from label log 
files (Log Viewer) • 

Code Converter label conversion utility • 
Extended RFID tag support • 
OLE Automation  • 
Dynamic Data Exchange (DDE) •

FEATURE LM QuickDraw LABEL MATRIX LM PowerPro
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System Requirements
• IBM-compatible PC, 486 or better

• Microsoft Windows 98 SE, Windows Me, Windows NT 4.0, 
Windows 2000, Windows XP or Windows Server 2003

• 32 MB RAM with Windows 98 SE or Windows Me (64 MB 
recommended)

• 64 MB RAM with Windows NT 4.0 or Windows 2000 (128 
MB recommended)

• 128 MB RAM with Windows XP (256 MB recommended)

• 256 MB RAM with Windows Server 2003 (512 MB recom-
mended)

• Hard drive with at least 150 MB free disk space

• SVGA monitor or better

• CD-ROM drive

• Mouse

Product Components 

Your label design software is packaged with the following
components:

• CD-ROM

• Documentation appropriate for the version you purchased

Viewing the Readme File

The Readme.txt file that installs with the software contains
information about the most recent changes and updates to the
label design software that were made after this manual was
printed. This information supersedes what is contained in this
manual.

The edition and release number for your software 
are printed on a label placed on this guide and 
also on the LABEL MATRIX box.



2

Installing LABEL MATRIX

Before Installing
• Disable all anti-virus software.

• Close all other applications that are currently running.

Software Installation

Note If you have already downloaded and installed the current 
LABEL MATRIX Demo, there is no need to install again from the 
CD. Proceed to the "Activating the Software" section on page 
2-7 for instructions on activating the software and converting 
it from a trial version to a full product.

Full Install X To perform a full install:

1 Insert the LABEL MATRIX 8 CD. 

The CD’s opening screen will appear. If the CD does not 
automatically open, on the taskbar, click the Start button, 
and then click Run. Type the letter of the CD-ROM drive 
followed by CDSetup.exe (e.g., D:\CDSetup.exe).

Local administrative privileges are required for 
proper installation and activation. Contact your 
system administrator for assistance.

e
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Figure 2-1 LABEL MATRIX 8 CD Opening Screen

2 On the opening screen of the CD, click on LABEL MATRIX 
8, and then click the Install button. 

3 Select the desired language for the software interface 
screens, and then click OK.

The Preparing to Install screen will appear, followed by 
the welcome screen for the installation wizard.

4 Follow the on-screen instructions through the wizard until 
you reach the Destination Folder screen.
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Figure 2-2 Set Destination Folder

5 The Destination Folder screen shows the default instal-
lation folder (C:\Program Files\LM8\).

It is recommended that you leave the installation location 
at its default setting. If it is necessary to install to a differ-

ent location, click the Change button and specify the new 
location.

6 Click Next.
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Figure 2-3 Custom Setup

7 On the Custom Setup screen, you can click on a program 
feature in the list to view the amount of hard drive space 
required to install the feature.

By default, all listed features (graphic files, Pick List files, 

conversion utilities, sample labels, etc.) will be installed. 

To deselect a feature, click its  icon and then click 

This feature will not be available.

Note Click the Help button on this screen to view the different install 
state icons and their meanings.

8 Click Next.

9 Click Install.

The installation wizard installs the LABEL MATRIX soft-
ware. This may take several minutes.
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When the wizard has completed the install, a message 
appears to inform you that LABEL MATRIX 8 has been 
installed successfully.

10 Click Finish to exit the wizard.

11 Do one of the following:

• If you are installing a single-user license, you now 
have the option to run the software for a trial period of 
30 days or 100 executions before activating it. When 
you are ready to activate the software, proceed to the 
"Activating the Software" section on page 2-7.

• If you are installing a network license, proceed to 
Chapter 3, "Network Licensing Setup" to install the 
network management utilities and set up users.

Version Upgrade If you are upgrading from LABEL MATRIX 5.X or LABEL MATRIX
7.X, you must use the Migration Tool on the LABEL MATRIX CD
to transfer your existing license to a LABEL MATRIX 8 license.
This license migration is necessary in order to activate the new
version of LABEL MATRIX you have purchased.

X To upgrade your LABEL MATRIX 5.X or 7.X license to 
a LABEL MATRIX 8 license:

1 Install the new LABEL MATRIX 8 software according to the 
instructions on page 2-1.

2 On the opening screen of the LABEL MATRIX 8 CD, click on 
the Migration Tool installation item.

All users (including Power Users, Users, Back-
ground Operators, etc.) must have Full Control 
permissions to the LABEL MATRIX “Drivers” 
folder (i.e., C:\Program Files\LM8\Drivers). To 
check this, use Windows Explorer to browse to 
the Drivers folder, right-click on the folder, and 
click Properties. Click the Security tab and ver-
ify that Full Control permissions are allowed for 
all users.
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Figure 2-4 Migration Tool on the CD

3 If you purchased a Version Upgrade, a Migration Tool 
instruction sheet will be included in your product box. In 
addition, it is available in PDF format from the opening 
screen of the CD by clicking on the Migration Tool item 
and then clicking the Documents button.

Follow the steps provided on the Migration Tool instruction 
sheet to migrate your license.

4 Activate the software according to the instructions on 
page 2-7.

If you are upgrading from a previous LABEL 
MATRIX 5.X or 7.X license, you must first install 
the new LABEL MATRIX 8 software, then migrate 
your license using the Migration Tool, and finally, 
activate the software.
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Edition Upgrade 
or Adding Users

If you are performing an Edition Upgrade (e.g., from LABEL
MATRIX version 8 to LABEL MATRIX PowerPro version 8) or if
you are adding users, you do NOT need to reinstall the
software.

X To perform an Edition Upgrade or add users:

• If you have purchased an Edition Upgrade or Add-on 
licenses, your product box will contain a “TEKLYNX 
Upgrade Program” document that includes a printed label 
with your product serial number. To perform the upgrade, 
follow the detailed instructions included in this document. 

Activating the Software

Once you have installed LABEL MATRIX, the Activation Wizard
will take you through the process of activating the software.

Note For network licenses, the software is activated through the 
network utility, so the Activation Wizard will not appear when 
you start the program as it does with a single-user version.

X To activate the software:

1 Start LABEL MATRIX.

A welcome screen appears displaying options to activate 
the software immediately or to try it for an evaluation 
period.
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Figure 2-5 Activation Wizard

2 Click Activate, and then click Next.

The Select Activation Mode screen appears.



Installing LABEL MATRIX Chapter 2-9

Figure 2-6 Select Activation Mode

3 Select from three options for the activation method 
(Automatic (Internet), Fax/e-mail, or Telephone), 
and then click Next.

4 Depending on the activation method selected, follow the 
appropriate steps to complete the activation process.

Note Once the software has been activated, the Activation Wizard 
will no longer appear upon startup, and you will be able to use 
the software with all features and functionality enabled.
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Automatic (Internet) Activation Method

1 Fill in all required fields on the User Registration screen, 
and then click OK.

2 On the Internet Activation screen, enter the Activation 
Code you received with the product, and then click Next. 

A message will appear to inform you that activation was 
successful. If any problems are encountered, a message 
will inform you that activation has failed.

3 Click Finish to complete the activation process.

Fax/e-mail Activation Method

1 Fill in all required fields on the User Registration screen, 
and then click OK.

2 On the Activation Code screen, enter the Activation Code 
you received with the product, and then click Next. 

3 Click the Create Form button.

An Activation Request Form will be created with all of the 
required user information. This form must be sent via fax 
or e-mail in order to receive a Response Code. For sending 
instructions, please refer to the contact information given 
on the screen.

4 Click Next.

While waiting for a Response Code, you may choose to 
launch your software and begin using it, or close it and 
return to the activation process once you have received 
your Response Code. (Note: Once you return to the wiz-
ard, all options you previously selected in the wizard will 
be retained.)

5 Once you have received your Response Code, you can 
return to the activation process by restarting the wizard 
and then clicking Next until you reach the screen that 
includes the option to Enter the Response Code. 
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6 Enter the Response Code provided to you, and then click 
Next.

A message will appear to inform you that activation was 
successful. If any problems are encountered, a message 
will inform you that activation has failed.

7 Click Finish to complete the activation process.

Telephone Activation Method

1 On the Phone Activation screen, enter the Activation 
Code you received with the product, and then click Next. 

2 Call the appropriate phone number for your area (pro-
vided on the screen).

You will be required to give all user registration informa-
tion over the phone, so please have your company infor-
mation at hand before calling.

3 Enter the Response Code provided to you, and then click 
Next.

A message will appear to inform you that activation was 
successful. If any problems are encountered, a message 
will inform you that activation has failed.

4 Click Finish to complete the activation process.
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Network Licensing Setup

License Management

The license management utilities, included with the network
(multi-user) packages, allow you to control access to the label
design software licenses across the network. Using one of
these utilities, you can have many users accessing the label
design software at the same time, from anywhere on the
network. When users are logged onto the program, their user
names will appear in the users list so administrators can keep
track of who is using the program.

Depending on your system setup, you may choose to install
one of the following license management utilities:

• The License Manager utility (LMLicenseManager.exe) is 
the standard licensing program that must be started man-
ually each time your system is powered on. License Man-
ager must be running in order for users on the network to 
have full access to the label design software. If this pro-
gram is not active, then all users will operate in Demo 
Mode. 

• The License Service utility (SLicenseCtrl.exe) is similar 
to License Manager, but runs as a service, which means it 
launches automatically when the system is powered on 
and will run as a background task as long as the system is 
on. 

e
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X To install the license management utility:

1 Please note the following BEFORE installing License 
Manager or License Service:

• In most cases, it is recommended that you install the 
LABEL MATRIX software first, followed by the installa-
tion of the license management utility.

• The license management utility need only be installed 
one time in one central location (either on a central 
server or other shared workstation with all users 
mapped to it).

• Implementation and setup of the license management 
utilities require full administrative privileges on the 
license server, and cannot be set up remotely (i.e. 
cannot be set up using Remote Desktop).

• The installation folder of the license management util-
ity (by default, C:\Program Files\LM8 Network) must 
be a shared and mapped letter drive, allowing 
other workstations full control, read/write, and modify 
rights. Without full control access, the user will stay 
logged into the licensing utility even after closing the 
label design software.

• The license management utilities are not compatible 
with Novell systems, so Novell network users must 
designate a Windows workstation to be the license 
server.

2 Insert the LABEL MATRIX 8 CD on the computer chosen to 
act as the license server.

The CD’s opening screen will appear. If the CD does not 
automatically open, on the taskbar, click the Start button, 
and then click Run. Type the letter of the CD-ROM drive 
followed by CDSetup.exe (e.g., D:\CDSetup.exe).

3 On the opening screen of the LABEL MATRIX CD, select 
Network Manager, and then click Install.
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Figure 3-1 Network Manager on the CD

The install program begins preparations for the LABEL 
MATRIX Network Utilities setup process (this may take a 
moment).

4 On the wizard’s Welcome screen, click Next to continue 

with the installation of the network licensing utilities.

5 Follow the on-screen instructions through the wizard until 
you reach the Destination Folder screen.
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Figure 3-2 Set Destination Folder

6 The Destination Folder screen shows the default instal-
lation folder (C:\Program Files\LM8 Network\).

It is recommended that you leave the installation location 
at its default setting. If it is necessary to install to a differ-

ent location, click the Change button and specify the new 
location.

7 Click Next.

8 Now on the Setup Type screen, choose the setup type 
that best suits your needs:

• Select the Complete install option if you want both 
license management utilities (License Manager and 
License Service) to be installed. 

• Select the Custom install option if you want to specify 
to install either the License Manager or License Service 
utility, or specify to install both utilities.

9 Click Next.

If you selected the Custom install option, the Custom 
Setup screen appears.
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Figure 3-3 Custom Setup

10 Select the license management utility (or utilities) to 
install — either License Manager and/or Service Instal-
lation (License Service) — and then click Next.

11 On the Ready to Install screen, click Install to begin 

installing the LABEL MATRIX Network Utilities.

12 When the installation is complete, click Finish to exit the 
install wizard.
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Setting Up a Network Version
1 Install the LABEL MATRIX software according to the "Soft-

ware Installation" section on page 2-1.

2 Install the license management utility (either License 
Manager or License Service) according to the "License 
Management" section on page 3-1. 

3 Start the LABEL MATRIX software. (You may see errors 
upon opening, before the network configuration has been 
performed).

4 Install and select your printer. (For information on printer 
setup, see Chapter 4, "Printer Setup").

5 In LABEL MATRIX, go to Tools menu > Setup > Network 

tab. Check the Network Key box, and use the  button 

or Auto Find... button to browse to the mapped letter 
drive location of the network utility’s root directory (i.e., 
C:\Program Files\LM8 Network\).

6 Close LABEL MATRIX.

7 On the license server, run the license management utility 
you installed — either License Manager 
(LMLicenseManager.exe) or License Service 
(SLicenseCtrl.exe) — found by clicking the Windows Start 
button and then going to All Programs > Teklynx > 
LABEL MATRIX 8. 

8 The Activation Wizard appears. Follow the instructions in 
the "Activating the Software" section on page 2-7 to acti-
vate your network version.

Each workstation requires a mapped letter 
drive in order to properly access the license 
management utility on the license server. The 
root directory of the software (i.e., C:\Program 
Files\LM8 Network) must be shared and mapped 
allowing other workstations full control, read/
write, and modify rights to all potential users.
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Note If the license management utility is not activated, LABEL 
MATRIX will run in Demo Mode.

9 Start the LABEL MATRIX software again. If the license 
server install was configured properly, LABEL MATRIX will 
open without error, and License Manager or License Ser-
vice should reflect one user accessing the program. If 
unsuccessful, refer to Appendix A, "Troubleshooting 
Installation Issues" before continuing.

10 Install the LABEL MATRIX software on each workstation 
where the label design software will be used (do NOT 
install the license management utility on the worksta-
tions). Through Windows, map to the license server (the 
network drive where the license management utility is 
installed). 

11 For each installation repeat Step 5. Only this time, browse 
to the network utility’s root directory on the mapped letter 
drive from Step 10.

12 Shut down and restart LABEL MATRIX to complete the net-
work installation.

Each workstation requires a mapped letter 
drive in order to properly access the license 
management utility on the license server. Refer to 
your Windows documentation or ask your system 
administrator for the necessary instructions.



Chapter 3-8 Installation Guide

Using License Manager 
1 On the Windows taskbar, go to Start > All Programs > 

Teklynx > LABEL MATRIX 8 > License Manager.

The License Manager dialog box appears displaying a list 
of users, if any, who are currently using the label design 
software.

Figure 3-4 License Manager

2 Use the following buttons to update and display informa-
tion in License Manager:

 Closes License Manager.

 Updates the display to show the users currently 

logged into the label design software. (The display is auto-
matically updated every few seconds.) Note: If the display 
is not refreshing correctly to reflect the actual user status, 
verify that the users who are logging out have the 

required permissions (full control, read/write, and modify 
rights) needed to delete their user listings as they log out.

 Displays License Manager version information.

3 Click  to exit License Manager.
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Using License Service

Note License Service runs only on Windows NT, 2000, XP and 
Windows Server 2003 systems.

1 On the Windows taskbar, go to Start > All Programs > 
Teklynx > LABEL MATRIX 8 > License Service.

The License Service dialog box appears displaying a list 
of users, if any, who are currently using the label design 
software.

Figure 3-5 License Service

2 Click Start  to start License Service. Once it is started, 

from then on the service will launch automatically when 
the system is powered on and will run as a background 
task as long as the workstation/server is on.
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3 Use the following buttons to update the users list, config-
ure settings, and display information in License Service:

 Updates the display to show the users currently 

logged in to the label design software. (The display is 
automatically updated every few seconds.) Note: If the 
display is not refreshing correctly to reflect the actual user 
status, verify that the users who are logging out have the 
required permissions (full control, read/write, and modify 
rights) needed to delete their user listings as they log out.

 Allows you to configure License Service settings 

including: specifying the license file path, setting the 
option to stop the service when users are connected, and 
selecting a display language.

 Displays License Service version information.

4 Click  to exit License Service.

Note
 

Exiting the License Service dialog box does NOT stop the 
service; it will continue to run as a background task. (To stop 
the service, click Stop  on the License Service dialog 
box.)
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Printer Setup

LABEL MATRIX supports over 1,000 specialized thermal and
thermal-transfer label printers and any printer with a valid
Windows driver supplied by the manufacturer. Printer drivers
included with this label design software are installed to the
program’s Drivers directory when the program is installed.

For optimum results when designing and printing labels in this
label design software, use one of the high speed printer drivers
installed with the program.

Adding a Printer

Printer Drivers The LABEL MATRIX and LM PowerPro editions of the software
contain printer drivers for thermal/thermal-transfer printers
from many different printer manufacturers. These printer
drivers are loaded on your computer when the program is
installed.

The printer drivers installed with this program enable you to
maximize your label printer’s capabilities by providing access
to the printer’s resident fonts, making the most efficient use of
the memory available and thereby greatly increasing your
printing speed.

For thermal and thermal-transfer printers, use 
only the drivers that are installed with LABEL 
MATRIX. If you use a driver that was installed 
through Windows, you may experience slow 
printing or encounter errors at print time.

e
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Depending on the printer you plan to use, there may be
several driver choices available in the software. Printer driver
types are designated in the label design software as follows:

• (L) Native Driver - Driver is a native software driver, 
developed specifically for use with this label design soft-
ware.

• (X) Extended Driver - Driver is from an extended driver 
set that provides support for hundreds of additional print-
ers.

• (W) Windows Driver - Driver is a Windows driver 
installed through Windows Control Panel. 

Some printers include both a native driver and an extended
driver for the same printer model. You may want to try all of
the drivers available for your particular printer model and
determine which one works best for your label printing needs. 

Add Printer 
Wizard

The Add Printer Wizard helps you add printer drivers for use
with LABEL MATRIX.

X To add a printer using the Add Printer Wizard:

1 On the File menu, click Printer Setup.

2 Click Add. 

The Add Printer Wizard appears.

3 Read through the information given on the first screen of 
the wizard, and then click Next to continue.

To specify a Windows printer as your default label 
printer, you must first add its printer driver using 
Windows Control Panel.
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Figure 4-1 Select printer make and model

On the Manufacturer/Printer screen, each printer’s instal-
lation status is indicated by one of the following icons: 

Driver is installed on the system and is available for
use with the label design software. 

Driver is supported by the label design software, but
is not currently installed. (In most cases the driver can
be downloaded from the Web free of charge using the
Driver Service Pack utility.) 

If you do not see your printer manufacturer and model in 
the list of available printers, you have several options:

• Your printer may use a Windows printer driver that is 
not supplied with the label design software. If so, you 
can install it through Windows Control Panel.

• Your printer may be the same as one of the printers 
listed, but it may have a different name. Your printer 
vendor may be able to suggest alternative printers for 
which the driver would be compatible.   

• An existing driver may support your printer through 
emulation. Your printer vendor may help you deter-
mine if a driver emulates your particular printer.

Note The Have Disk button allows you to install a printer driver 
from a disk or CD.



4 Select the manufacturer and printer that you want to use, 
and click Next.

The alias and port selection screen appears.

Figure 4-2 Specify alias and port

5 In the Alias box, type a name for the printer. For exam-
ple, “Warehouse Printer 1” or “Shipping Label Format - 
HP4”. This name will appear in the list of printers in the 
Printer Setup dialog box.

6 Specify the port to which your printer is physically con-
nected. 

• Local: Select a local port. Typically, thermal printers 
use a serial (COM port) connection such as COM1 or 
COM2. Laser and dot matrix printers typically use a 
parallel port (LPT) connection such as LPT1 or a USB 
port such as USB001.

• UNC: Enter the full UNC path to print using a shared 
network printer.

• TCP/IP: Enter the IP address to print using a shared 
Telnet connection.

Note To function properly, many serial printers need to be physically 
connected with a null modem cable or null modem adapter on 
a standard RS232 cable. 
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7 If printing to a local port (e.g., COM1, LPT1, or USB001), 
the Enable Windows Print Spooling option is available.

Print spooling allows you to send your print jobs to the 
Windows Print Spooler, which stores each print job until 
the printer is ready. The advantage of using print spooling 
is that the label design software will be available for use 
much quicker immediately following each print job 
because it is not tied up with the direct printing process.

8 Click Next.

9 If you chose a COM port, a COM port settings screen 
appears.

Figure 4-3 COM port settings

Adjust the COM port settings if necessary according to 
your printer manual specifications. The COM port settings 
specified here should match the settings on your printer. 

You may be instructed to use Windows Control Panel to 
change the connection information if your printer is using 
a Windows-supplied driver.

10 Click Next.
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11 You have now entered all the information needed to attach 
a printer.

To display printer settings after you exit the wizard, click 
the Change printer setup options check box.

12 Click Finish.



5

Setting Up System Security

The system security feature (available only in LABEL MATRIX
and LM PowerPro editions) allows you to restrict users to
certain features of the program. You can set up system
security by assigning a user ID and password and then
selecting the tasks the user may perform. When you restart
the program after setting up a user, the security feature is
enabled, and all users will be required to log in before using
the program. 

You can set up secured access to label design functions by
establishing a list of users, each with their own user name and
password. Secured access means that each time the label
design software is started, the user is prompted to enter a user
name and password.

The first user to set up a password is automatically granted
administration privileges. That user can then add users by
defining the user name, password, and access privileges for
each user. Thereafter, when a user starts the label design
software, he or she must enter a correct user name and
password to be allowed access to the functions assigned to him
or her.

To each user you can grant access to one or more of these
Design Program areas:

• Design: Allows users to design labels.

• Print: Allows users to print labels.

• Database: Allows users access to the database functions 
available on the Label Properties > Database tab, and 
allows access to the database module via the Tools menu.

e
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Note Without Database access, users that have Design access are 
still allowed to attach databases to labels when assigning a 
Database origin.

• Edit Grid: Giving users access to the Edit Grid function 
allows them to edit database records directly from the 
program’s Data Grid. Note that editing is limited to Access 
and FoxPro databases. 

• Administration: Allows users to add and modify user 
security. The first user to set up a password is automati-
cally granted administration privileges.

To each user you can grant access to one or more of these
Print Only areas:

• Reanalyze Datasource: Allows users to reanalyze a 
database for the total number of records and for updated 
field property information.

• Save Image Values: Gives users the option of keeping 
changes to Counter or Keyboard Input values after print-
ing.

• Change Printer: Allows users to add a printer or change 
the selected printer.

X To define users for system access:

1 On the Tools menu, click Setup.

2 Click the Passwords tab.
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Figure 5-1 Passwords tab

3 Click Add. The Add User dialog box appears.

Figure 5-2 Add Users

Note If you are the first user to set up a password, the access 
options are selected by default.
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4 In the User Name box, type the name that you want the 
user to enter to access the system.

5 In the Enter Password box, type the user’s password. 
For security, asterisks (*) appear in place of the charac-
ters you type.

6 In the Retype Password box, type the password exactly 
as you did before.

7 If the check boxes are available, select the functional 
areas to which this user should have access.

8 Click OK.

The user appears in the User List box.

Figure 5-3 User List

9 Click OK.

With password security enabled, users will now be 
prompted for a user name and password each time the 
program is started. 



Troubleshooting

A

Installation Issues

The following table lists the most common error messages, issues, and questions
encountered when installing the LABEL MATRIX software. 

For the most current information on installation issues and troubleshooting tips,
please reference the LABEL MATRIX FAQs page on the TEKLYNX web site at 
http://www.teklynx.com/products/labels/labelmatrix_faq.html. The LABEL
MATRIX FAQs are also available directly from within the LABEL MATRIX software by
going to Help menu > Teklynx Online > Top 10 FAQs.

Problem/Question Solution

Installation/Activation Issues

I’m trying to install the soft-
ware but it’s asking me for a 
code in order to “activate” it? 
Where do I get this code? 

If you are installing a full version of the 
software, an Activation Code will be pro-
vided in your product box.

If you are upgrading from LABEL MATRIX 
5.X or LABEL MATRIX 7.X, a Migration Tool 
instruction sheet will be included in your 
product box. Follow the instruction sheet to 
“migrate” your existing license to a LABEL 
MATRIX 8 license. At the end of the process 
you will receive an Activation Code that will 
allow you to activate the software. 

e
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What happens if I lose my 
Activation Code?

Please contact TEKLYNX Customer Service 
at 888-629-4444 or e-mail 
customerservice@teklynx.com. You will 
need to provide them with the serial num-
ber on your invoice or from the product box. 
They can then re-issue an Activation Code.

I used the Migration Tool 
utility, but I didn’t write 
down the Activation Code 
given at the end. Now what 
do I do? 

I installed the software as a 
trial version at first, and then 
a few days later I activated it 
using the code provided in 
my product box. The problem 
is, after I activated it, sev-
eral of the features I was 
using in the trial version 
were suddenly not available. 
Why is this?

If an option appears “grayed out” and is not 
available for selection in the activated soft-
ware, this is most likely because that fea-
ture is not included in the edition you 
purchased. When you run the trial version, 
it automatically defaults to running the LM 
PowerPro (high-end) edition of the soft-
ware. When you activate it, it runs the edi-
tion you actually purchased (probably 
LABEL MATRIX or LM QuickDraw).

A detailed listing of features included in 
each edition can be found in the "LABEL 
MATRIX Editions" section on page 1-2 of 
this guide.

What if the PC crashes or I 
need to transfer the license 
to another PC? 

You must contact Customer Service and 
provide them with your Activation Code. 
Another authorization code will be given to 
reactivate the product.

What if the PC crashes in the 
middle of the night, over the 
weekend, or on a holiday - 
how can I reactivate the 
product with no down time?

By installing the CD on another PC, you 
start with a grace period during which you 
run the software as a trial version. All prod-
uct features will be available during that 
period, which gives you time to continue 
using the software with no down time, until 
you can contact Customer Service to reacti-
vate your product.

What happens if I uninstall 
the software by accident and 
need to re-install it on the 
same PC later?

As long as you have not formatted your 
hard disk, your product will run without 
requiring a new Activation Code. 

(Table continued from previous page)

Problem/Question Solution
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I lost the CD and I need to 
re-install the software. What 
do I do?

If you lost the CD and need to re-install, 
you can download the re-installation files 
from the TEKLYNX web site at http://
www.teklynx.com/products/labels/
labelmatrix_downloads.html. As long as you 
are installing to the same PC and have not 
formatted your hard disk, this is all that is 
needed to re-install the software.

I installed a demo version 
that I downloaded from the 
web site. Can I turn this into 
a full license without having 
to re-install the product? 

Yes. When you purchase a product you will 
receive an Activation Code. You can use this 
Activation Code to activate the trial version 
without having to re-install.

Error 432: Setup has 
detected that InstallShield is 
in use. Please close 
InstallShield and restart 
setup.

This is an InstallShield error that can occur 
for a number of reasons. For information on 
resolving this issue, go to 
http://consumer.installshield.com and 
search on “Error 432”.

General Questions

How do I know that the CD I 
received contains the latest 
release of the software, 
including any recent patches 
or updates?

You can verify this by checking your soft-
ware version number against the version 
number of the LABEL MATRIX Demo found 
at http://www.teklynx.com. The LABEL 
MATRIX Demo is always updated with the 
most recently released version of the soft-
ware. Please verify that your version 
matches the Demo version. 

Why are some features and 
options grayed out or not 
available?

Many of the features covered in the LABEL 
MATRIX Quick Start Guide and online Help 
are available only in the mid-range (LABEL 
MATRIX) or high-end (LM PowerPro) edi-
tions of the software. If an option appears 
“grayed out” and is not available for selec-
tion, this is most likely because that feature 
is not included in the edition you purchased.

A detailed listing of features included in 
each edition can be found in the "LABEL 
MATRIX Editions" section on page 1-2 of 
this guide.

(Table continued from previous page)

Problem/Question Solution
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Where can I find sample 
labels, training manuals, and 
tutorials? 

Sample label design files and compliance 
label templates can be found in the pro-
gram’s Sample Labels folder (i.e., C:\Pro-
gram Files\LM8\Sample Labels). You can 
also access many helpful resources directly 
from within LABEL MATRIX by going to the 
Help menu > Teklynx Online.

In addition, both BASIC and ADVANCED 
level training manuals (including step-by-
step tutorials) are available from TEKLYNX 
for a fee. For more information, please con-
tact TEKLYNX Customer Service.

What Technical Support is 
available? 

From within LABEL MATRIX go to the Help 
menu > Teklynx Online. From here you 
can quickly access many support resources 
including eHelp videos, Technical Support 
FAQs, PDF format manuals and guides, and 
more. 

For phone support, please contact your 
label design software supplier.

(Table continued from previous page)

Problem/Question Solution
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